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About this Manual

UZR 3D Professional is a software product that
enables you to reconstruct 3D models from 2D
object images. The UZR 3D Professional work-
flow is as simple as possible:

• The desired object is placed on the object
pattern. This pattern can be printed on
standard paper with every printer.

• Photographs are taken from all sides of
the object.

• The object images are loaded into UZR
3D Professional.

• The 3D model is automatically recon-
structed and textured.

• The 3D model then can be exported into
other 3D modeling software or for usage
in the internet.

The third part of this introduction features a
UZR 3D Professional workflow description.
We also included a tutorial. With the tutorial
files included on your UZR 3D Professional CD
ROM, you can follow the tutorial step by step
and get to know the software.

The UZR 3D Professional Reference features
lists of all UZR 3D Professional functions and
shortcuts that will make working with UZR 3D
Professional even easier for you.

Additionally, we included some hints dealing
with the proper image acquisition. If you take

the advice to heart, you will be able to reason-
ably improve your 3D results.

Notation

 Caution Under this header you will find hints
to what has to be considered/prevented while
working with UZR 3D Professional.

 Tip Under this header you will find useful hints
on how the UZR 3D Professional workflow is
improved.



Copyrights and License Agree-
ment

2.1 Copyright 

All rights reserved. This documentation and the
software are copyrighted. Neither the whole nor
parts of it are allowed to be copied, reproduced,
distributed or translated.

During the creation of this software and the
appendant documentation, we exercised great-
est care. Still, mistakes can always happen.
Thus, UZR GmbH & Co KG can not be made
liable for any damages ascribed to mistakes in

the documentation or malfunctions of the soft-
ware.

UZR and UZR 3D are registered trademarks of
UZR GmbH & Co KG.

All other brands, products and company names
mentioned herein may be trademarks or regis-
tered trademarks of their respective holders. 

2.2 UZR GMBH & CO KG License Agreement for UZR 3D 
Professional 

NOTICE TO USER

WITH THE INSTALLATION OF UZR 3D
PROFESSIONAL, A CONTRACT IS CON-
CLUDED BETWEEN YOU AND UZR
GMBH & Co KG, IN THE FOLLOWING
CALLED THE "LICENSOR", A COMPANY
UNDER GERMAN LAW WITH RESIDENCE
IN HAMBURG, GERMANY. "YOU" AND
THE "USER" REFERS TO THE LICENSEE.
WHEREAS BY INDICATING YOUR
ACCEPTANCE BELOW, YOU ACCEPT
ALL THE TERMS AND CONDITIONS OF

THIS AGREEMENT. IN THE CASE OF
NON-ACCEPTANCE OF THIS LICENSE
YOU ARE NOT PERMITTED TO INSTALL
THE SOFTWARE. IF YOU DO NOT
ACCEPT THIS LICENSE PLEASE SEND
THE SOFTWARE TOGETHER WITH THE
DOCUMENTATION TO UZR GMBH & CO
KG OR TO THE SUPPLIER WHERE YOU
BOUGHT THE SOFTWARE.
2



1. General

Under this contract the licensor grants to you a
non-exclusive license to use UZR 3D Profes-
sional, which is software and documentation, in
the following called the "software". The soft-
ware itself as well as the copy of the software or
any other copy you are authorized to make
under this contract remain the property of the
licensor.

2. Use of the Software

(1) The user of this license is authorized to copy
the software as far as the copy is necessary to
use the software. Necessary copies are the
installation of the program from the original
disk to the mass storage medium of your hard-
ware as well as the loading of the program into
RAM.

(2) Furthermore the user is entitled to make a
backup copy. However only one backup copy
may be made and kept in store. This backup
copy must be identified as a backup copy of the
licensed software.

(3) Further copies ARE NOT ALLOWED; this
also covers the making of a hard copy of the
program code on a printer as well as copies, in
any form, of the documentation.

3. Multiple use and network operation

(1) The use of the licensed software for network
operation or other client server systems is pro-
hibited if this opens the possibility of simulta-
neous multiple use of the software. In the case
that the user intends to use the software in net-
work operation or other client server system he
has to take care that a multiple use is not possi-

ble by employing the necessary access security
or otherwise the user has to pay to the licensor a
special network license fee, the amount of
which is determined by the number of users
admitted to the network.

(2) The license fee for networks will be com-
municated to the licensee by the licensor imme-
diately after the user has indicated the number
of admitted users in writing. The correct
address of the licensor is given in the manual
and also at the end of this contract. The network
use may start only after the pertaining license
fee is completely paid.

4. Transfer

(1) You may not rent, lease, sublicense or lend
the software or documentation. You may, how-
ever, transfer all your rights to use the software
to another person or legal entity provided that
you transfer this agreement, the software,
including all copies, updates or prior versions
as well as all copies of the font software con-
verted to other formats and all documentation to
such person or entity and that you retain no cop-
ies, including copies stored on a computer and
that the other person agrees that the terms of
this agreement remain valid and that his accep-
tance is communicated to the licensor.

(2) The user is obliged to carefully store the
terms of the agreement. Prior to the transfer of
the software the user has to inform the new user
of these terms. In case the user does not have
the terms at hand at the time of the transfer of
the software, he is obliged to request a second
copy from the licensor, the cost of which is
born by the licensee.
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(3) In case of transfer the license of the former
user expires.

(4) You may not transfer the software if you
received an update or upgrade. The old serial
number and the old license expire in this case.

5. Recompilation and changes of the 
software

(1) The recompilation of the provided program
code in other code forms as well as all other
types of reverse engineering of the different
phases of software production including any
alterations of the software are not allowed.

(2) The removal of the security against copy or
similar safety systems is only permitted if a
faultless performance of the software is
impaired or hindered by such security. The bur-
den of proof for the fact that the performance of
the program is impaired or hindered by the
security device rests with the user.

(3) Copyright notices, serial numbers or other
identifications of the software may not be
removed or changed. The software is owned by
the licensor and its structure, organization and
code are the valuable trade secrets of the licen-
sor. Except as stated above, this agreement does
not grant you any intellectual property rights on
the software.

6. Limited warranty

The parties hereto agree, that at present it is not
possible to develop and produce software in
such a way that it is fit for any conditions of use
without problems. The licensor warrants that
the software will perform substantially in accor-
dance with the documentation. The licensor

does not warrant that the software and the docu-
mentation comply with certain requirements
and purposes of the user or works together with
other software used by the licensee. The user is
obliged to check the software and the documen-
tation carefully immediately upon receipt and
has to inform the licensor in writing of apparent
defects 14 days after receipt. Latent defects
have to be communicated in the same manner
immediately after their discovery. Otherwise
the software and documentation are considered
to be faultless. The defects, in particular the
symptoms that occurred, are to be described in
detail in as much as the user is able to do so.
The warranty is granted for a period of 6
months from delivery of the software (for the
date of which the date of the purchase accord-
ing to the invoice is decisive, respectively in
case of shipment by the licensor the date of the
invoice). The licensor is free to cure the defects
by free repair or provision of a faultless update.
The licensor and its suppliers do not and cannot
warrant the performance and the results you
may obtain by using the software or documen-
tation. The foregoing states the sole and exclu-
sive remedies for the licensor's or its suppliers'
breach of warranty, except for the foregoing
limited warranty. The licensor and its suppliers
make no warranties, express or implied, as to
noninfringement of third party rights, mer-
chantability, or fitness for any particular pur-
pose. In no event will the licensor or its
suppliers be liable for any consequential, inci-
dental or special damages, including any lost
profits or lost savings, even if a representative
of licensor has been advised of the possibility of
such damages or for any claim by any third
party. Some states or jurisdictions do not allow
the exclusion or limitation of incidental, conse-
quential or special damages, or the exclusion of
4



implied warranties or limitations on how long
an implied warranty may last, so the above lim-
itations may not apply to you. In this case a spe-
cial limited warranty is attached as exhibit to
this agreement, which becomes part of this
agreement. To the extent permissible, any
implied warranties are limited to 6 months. This
warranty gives you specific legal rights. You
may have other rights which vary from state to
state or jurisdiction to jurisdiction. In the case
that no special warranty is attached to your con-
tract please contact the licensor for further war-
ranty information.

7. Damage in transit

The user is obliged to immediately inform the
transport agent in writing of any eventual dam-
ages in transit and has to provide the licensor
with a copy of said correspondence, since all
transportation is insured by the licensor if ship-
ment was procured by him.

8. Secrecy

The user is obliged to take careful measures to
protect the programs and their documentation,
in particular the serial number, from access by
third parties. The user is not permitted to dupli-
cate or pass on the program or documentation.
These obligations apply equally to the user's
employees or other persons engaged by the user
to operate the program. The user will pass on
these obligations to such persons. The user is
liable for damages in all instances where these
obligations have not been met. These obliga-
tions apply equally to the user's employees or
other persons he entrusts to use the software.
The user will pass on these obligations to such
persons. The user is liable to pay the licensor all

damages arising from failure to abide by these
terms.

9. Information

In case of transfer of the software the user is
obliged to inform the licensor of the name and
full address of the transferee in writing. The
address of the licensor is stated in the manual
and at the end of this contract.

10. Data Protection

For the purpose of customer registration and
control of proper use of the program licensor
will store personal data of the users in accor-
dance with the German law on Data Protection
(Bundesdatenschutzgesetz). This data may only
be used for the above-mentioned purposes and
will not be accessible to third parties. Upon
request of the user the licensor will at any time
inform the user of the data stored with regard to
him.

11. Other

(1) This contract includes all rights and obliga-
tions of the parties. There are no other agree-
ments. Any changes or alterations of this
agreement have to be performed in writing with
reference to this agreement and have to be
signed by both contracting parties. This also
applies to the agreement on abolition of the
written form.

(2) This agreement is governed by German law.
Place of jurisdiction is the competent court in
Hamburg. This agreement will not be governed
by the United Nations Convention on Contracts
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for the International Sale of Goods, the applica-
tion of which is expressly excluded.

(3) If any part of this agreement is found void
and unenforceable, it will not affect the validity
of the balance of the agreement which shall
remain valid and enforceable according to its
terms.

12. Termination

This agreement shall automatically terminate
upon failure by you to comply with its terms
despite being given an additional period to do
so. In case of termination due to the aforemen-
tioned reason, user is obliged to return the pro-
gram and all documentation to licensor.
Furthermore, upon request of licensor user has
to submit written declaration that he is not in
possession of any copy of the program on data
storage devices or on the computer itself.

13. Information and Notices

Should you have any questions concerning this
agreement or if you desire to contact UZR
GMBH & CO KG for any reason and for all
notifications to be performed under this agree-
ment, please write to:

UZR GMBH & CO KG Eiffestraße 422 D-
20537 Hamburg Germany
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What's New in 1.4?

This section will give you an overview on the
new features implemented in version 1.4 of
UZR 3D Professional. 

You have suggestions on what to realize in
future versions of UZR 3D Professional? Great,
we are looking forward to your comments!
Simply write an email to support@uzr.de. 

3.1  New Calibration Engine 

You are used to the fact that UZR 3D Profes-
sional produces great results, but these results
have even been improved with the new image
calibration engine. 

Manual Calibration 

The opportunity to control the calibration man-
ually allows you to directly interact with the

reconstruction process and even use images that
could not be calibrated during the automatic
calibration.

Calibration accuracy display 

The calibration accuracy display allows a better
analysis of the calibration results. This way,
you are able to improve your 3D results. 

3.2  New Texture Reconstruction 

The new and improved texture reconstruction
generates optimal maps from the object images.

You receive large texture parts perfectly suited
for further usage with other 3D software. Addi-
7



tionally, you can export these textures at any
resolution providing you with great rendering
results - even at the highest level of detail. A

number of different parameters enable you to
directly influence your texture results. 

3.3  New Masking Tools 

New masking tools improve the UZR 3D Pro-
fessional work flow: 

• Fill/Erase Mask: This tool fills/erases the
whole object mask. 

• Invert Mask: This tool inverts the existing
object mask. 

• Shrink/Grow Mask: This tool enables you
to increase/decrease the mask pixel by
pixel. This way, especially the edges of
the mask can easily be edited. 

• Import/Export Mask: This tool enables
you to edit masks with an external image
editing software. This way you can use
tools you are used to and that are not pro-
vided in UZR 3D Professional. 

• Import/Export Image: This tools enables
you to directly export a single object
image from the image list to your hard
drive. This image then can be edited and
directly imported back into the image list. 

3.4  New GUI Elements and Functions 

The user interface of UZR 3D Professional ver-
sion 1.4 contains new features that will improve
your work flow even further: 

• Positive/Negative Mask Display: 

The mask can be set to positive (the
masked object is colored) and negative
(the image background is colored) display
using the corresponding icons. This way,
the mask edge editing is improved. 

• Render-Toolbar: 

With the render toolbar, fast and easy
access to the 3D display settings is pro-
vided. 

• Deactivating Object Images: 

By deactivating the corresponding icons
underneath each object image in the
image list, you easily exclude single
8



object images from the voxel or texture
reconstruction process. This way, you do
not have to delete them from the image
list. An overview on all existing object
images is kept in the image list. 

• STL Export: With the STL export, UZR
3D Professional now supports the preva-
lent rapid prototyping format. 

• PSD and PCD Import: Photoshop and
Kodak Photo CD files can now directly
be imported in UZR 3D Professional

without having to convert them to another
image file format. 

• Import of an Existing Alpha Channel: If
you import PNG, PSD, TGA or TIF object
image files containing an alpha channel,
this alpha channel is detected and auto-
matically used for masking the object.
This way, images can directly be edited
with an image editing software and its
mask information is saved within the
object image. 

3.5 Improved UZR Export

UZR export with javascript controls 

The UZR export has been improved: exported
camera positions can directly be controlled with
javascript commands. This way you will be
able to create interactive web pages pointing on
special details of the model to the user. Addi-
tionally, the java applet display can be reset
without having to refresh the page. 
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Printing the Object Pattern 

UZR 3D Professional reconstructs a textured
3D model from a number of object images. In
order to acquire proper object images, you need
to print out the so-called object pattern. This
pattern can be printed with any printer using
standard paper. 

The object pattern

To print out the object pattern, choose Print
Pattern from the File menu. You can choose
from different sizes or create your own format. 

Printing the object pattern

The object pattern can be changed to any
desired size. Be sure to adjust the object pattern
size to the size of the object you want to recon-
struct. The bigger the object is compared to the
object pattern, the better details of the object
will be reconstructed. 

 Caution  Make sure that you selected the cor-
responding paper size in the setup menu of your
printer. If you want to print out an A3 object pat-
tern, you have to select the A3 paper size. 



Object Image Acquisition

5.1 Basics

The quality of a 3D model created with UZR 3D
Professional directly relates to the quality of the
object images from which the model is created.
If you are using faulty object images, you will
hardly be able to reconstruct an appealing 3D

model. That is why it is recommended to exer-
cise care during the object image acquisition.
Be sure to get sharp and unshaky object images.
Additionally, pay attention to the following
basic rules.

5.2 Object Image Acquisition Rules

If you take the following image acquisition
rules to heart, you will be able to noticeably
improve your 3D results and the convenience of
the 3D reconstruction process.

5.2.1 Object Pattern Size
Print out the object pattern on a white sheet of
paper. 

Wrong

Adjust the pattern size to the size of the object. 

Wrong

The pattern size should be as small as possible
compared to the size of the object. Make sure,
though, that, from every camera position, three
of the four pattern's corner points are visible. 
11



5.2.2 Preparing the Object Pattern
In order to achieve exact results, the object pat-
tern has to lay as flat as possible. 

Wrong

If the object pattern is undulated, the camera
position reconstructiojn will not be as exact as
required. You will not receive high quality
results.

Wrong

We recommend that you tape the pattern to a
flat piece of plastic, glass, or cardboard. Or you
tape the pattern directly onto a white table - this
way you will simultaneously receive a uniform
image background. 

5.2.3 Placing the Object on the 

Object Pattern
Place the object on the object pattern to acquire
the object images. 

Wrong

The object pattern has to lay as plane as possi-
ble and should not show an>y waves sharp
bends. The object should not cover any of the
object pattern's calibration points.

Correct

 Caution  The object's position should not be
changed during the object image acquisition
process. Ideally, move around the object taking
between 10 and 20 images from different posi-
tions. If that is not possible, carefully rotate the
object and the object pattern without moving the
object.
12



5.2.4 Uniform Illumination 

Try to illuminate the object as uniformly as pos-
sible. Use more than one light source to illumi-
nate the object. The less shadows the object
casts, the brighter the object colors will be cap-
tured and the better the object separation pro-
cess will work.

5.2.5 Uniform Image Background 
The more uniform the image background, the
easier it will be to separate the object from the
object image background. 

Wrong

Ideally, the object will be masked automatically
as in the tutorial included on your UZR 3D Pro-
fessional CD ROM. 

Correct

In most cases it is sufficient to place a white
blanket or large sheet of paper under to object
pattern to receive a very uniform image back-
ground.

5.2.6 Ideal Camera Angle
The best results are achieved if the images are
taken from an angle of about 45 degrees.

Wrong

Take some additional images from other angles
(e.g. from above) in order to reconstruct parts of
the object texture that would otherwise not be
visible in the object images.
13



Correct

 Caution  Be sure not to fall below an angle of
30 degrees. If the camera angle is to plane, UZR
3D Professional will not be able to detect the
calibration points of the object pattern.

5.2.7 Taking the Images
Take images from all sides of the object to
record all of the object's details. There have to

be three corner points visible in every object
image in order for UZR 3D Professional to cali-
brate the image. The more points are visible in
an object image, the better the camera position
can be reconstructed.

Always make sure that the whole object is visi-
ble in every object image and that parts are cut
off. If a part of the object is not visible on one
of the object images, this part will be cut away
by the 3D reconstruction process.

As soon as all images are taken, save the image
files to disk and start UZR 3D Professional.

 Tip  It is recommended to take more pictures
than normally required. This way you can
choose from a wider selection and do not have
to restart the object image acquisition process if
some of the images can not be calibrated.

5.3 Tips and Tricks

5.3.1 Sharpening the Image
Some digital cameras feature image sharpness
improvement. If you maximize this value, the
images do not become more focused. Instead,
the images' contrast is increased. This might
lead to faulty colors and frayed object edges.

 Tip  If you want to enhance your object image
quality it is recommended you use an image ed-
iting software product of your choice (e.g. Ado-
be Photoshop). Most image editing software
offers a wide selection of tools to improve color,
sharpness or illumination of your image. Plus,

the results are easier to control than on the
small LCD display of your digital camera.

5.3.2 Manual Alignment
Different illumination leads to different image
colors. The camera's alignment can be adjusted
to the prevailing illumination. The automatic
alignment feature of most digital cameras
works quite all right, although the quality of the
object images can in most cases be improved if
the alignment is adjusted manually. This
applies especially if contrasting color dominate
14



the scene. To adjust your camera's alignment
manually, choose the corresponding menu item
from the "settings" menu of your digital cam-
era. Focus on a white area. This "white" will
then be the reference color that all other colors
will be adjusted to.

 Tip  Use the object pattern as the alignment
reference.

5.3.3 The Camera's Flash
The camera's flash frontally sends out a strong
light impulse on the object. This might lead to
different colors and shades on the single object
images. That is why it is recommended to
resign the camera's flash. You will get better
results if you illuminate the scenery with a con-
stant light source.

5.3.4 Considering the Release 
Delay
Especially with cheap digital cameras there is a
considerable delay between the moment the
release is pressed and the moment the picture is
taken. You should take that into account by per-
sisting in your position after pressing the
release. This way, you make sure that you
receive focused images.

 Tip  Improve your images by using a tripod.

5.3.5 Camera Display
If you are not using a digital reflex camera or a
camera equipped with a digital viewer, the
image you see through the viewer might differ

from the image recorded. This might lead to
unusable object images since parts of the object
or the object pattern might not be visible. The
image shown on the camera's LCD display is
the 'right' image.

 Tip  Aim at the object and control the image on
the LCD display before recording.

5.3.6 The Ideal Image Resolution 
The higher the image resolution, the better the
results of the texture reconstruction will be.
You should adjust the object image resolution
depending on two things: 

• Size of your memory card:  

Always keep in mind that UZR 3D Pro-
fessional requires between 10 and 20
object images to reconstruct the object.
Highly resoluted images use up a lot of
space. If your camera is equipped with
only a small memory card, its memory
might be used up before all required
object images are taken.

• Power of your Computers CPU: 

The higher the object image resolution,
the bigger the calculating effort. If you
are using a rather old home computer, it is
recommended to resign on highly reso-
luted object images.

 

 Tip  The lowest recommended resolution , is
640 x 480 pixels. If you are using lower resolut-
ed images you won't be able to reconstruct a sat-
isfying object texture.
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5.3.7 Immediate Image Control
A big advantage of digital photography is that
the images are instantly ready without a film
having to be developed. Improve your results
by instantly checking the object image quality
on the LCD display of your camera. It is also
recommended to play around with your cam-
era's parameters since faulty images can be
deleted in a second.

5.3.8 Adjusting the Light Expo-
sure
Most digital cameras automatically adjust their
light exposure values depending on the given
scenery illumination. The brighter the focussed
object is illuminated, the more the image is
automatically darkened. You will improve your
image quality if you adjust the light exposure of
your digital camera. Raise the value if the
object is brightly illuminated and vice versa.

 Tip  It is recommended to experiment with your
camera's settings at the beginning of the image
acquisition process. If you control the results in-
stantly and adjust the settings, you will soon re-
ceive optimised results. Finish taking the object
images with these settings and start the 3D re-
construction with UZR 3D Professional.
16



Working with UZR 3D Professional

6.1 Starting UZR 3D Professional

To start UZR 3D Professional

• double click the UZR 3D Professional
icon on your desktop or

• double click an existing U3D file which
will then automatically be opened.

After starting, the writing www.uzr3d.com
appears in the user interface. By double click-
ing this writing, an Internet Explorer window is
opened and you are connected to the UZR 3D
discussion forum in the internet. Here, you get
support and have access to discussion threads
and current downloads.

The UZR 3D Professional user interface

6.2 The Adjust Mode

Opening the object images

Command Shortcut

Open Images... Apple+I
17



To open the object images with UZR 3D Pro-
fessional, choose Open images... (Apple-I)
form the File menu. The images are succes-
sively loaded into the image list on the left side
of the user interface. Due to the fact that UZR
3D Professional is a multithreaded application -
meaning that numerous actions can be per-
formed within the software at the same time -
you can start working with the object images
rightaway as soon as the first image appears in
the image list. The other object image files are
loaded in the background.

Editing the object image selection

You start your project in the Adjust mode. Use
this mode to check if you loaded the correct
object images and if the quality of the loaded
images is sufficient for the work with UZR 3D
Professional.

UZR 3D Professional uses all object images in
the image list to generate the 3D model. If you
loaded wrong images by accident, it is recom-
mended that you delete these images from the
image list. Use the commands from the Edit
menu or the image list context menu to edit the
image selection.

In order to receive a uniform 3D model texture,
you should make sure that the images' quality is
as consistent as possible. If some of the object
images reasonably differ from the others, you
can use the Adjust Brightness/Contrast... and
Adjust RGB... tools from the Tools menu to
enhance the images' quality.

If you wish to edit some of the loaded images
with an image editing software of your choice,
you can directly export them from UZR 3D
Professional, edit them and then import them
again. Use the commands Import image... and
Export image... from the Tools menu.

An additional image can be inserted directly
from the clipboard into the image list by using
the Paste as new command. This way, you do
not have to externally save images that you just
edited with another software before using them
with UZR 3D Professional. Simply copy the
whole image and paste it into the image list.

If you finished all the required changes, you can
activate the Calibrate mode (Calibrate index or
Apple-F2).

6.3 The Calibrate Mode 

 Automatic Image Calibration 

In order to reconstruct a 3D model from the

object images, UZR 3D Professional needs cer-
tain information about the camera that was used
18



to take the images: information about the posi-
tion of the camera as well as its zoom and focal
length are required. This information is
resonctructed from the calibration pattern. 

Calibrating the images

If you activate the Calibrate mode, UZR 3D
Professional detects visible pattern ellipses in
the object images. This information is then used
to reconstruct the required camera information,
a process called image calibration. 

Calibrated image

If a sufficient number of ellipses was detected,
the image is automatically calibrated. In the
image list, this image is then marked with green

crosses in the corner points of the calibration
pattern. 

Not calibrated image

If the image calibration failed, the image list
marks these images with a red cross. This way,
a quick overview on the calibration results is
provided. 

 Caution  Always make sure that a sufficient
number of object images is correctly calibrated.
On these images, the captured object should be
visible from every side and, if possible, from
above, in order to receive a satisfying 3D recon-
struction result. 

6.3.1  Analysing the Calibration 
Results 
In the work view, UZR 3D Professional circles
all detected ellipses with red color. The calibra-
tion results - the reconstruction of the object
pattern - are circled in green color. The better
the red and green ellipses fit, the better the cali-
bration results are. If the distance between the
ellipses is large, the calibration accuracy is low.
If an ellipse is yellow colored, UZR 3D Profes-
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sional detected an ellipse which then was not
used for calibration. 

The calibration display

The accuracy of the image calibration results is
displayed in the image list. Under each image
object, a colored bar represents this accuracy:
The wider this bar - the larger the calibration
value on the left -, the better the result of this
image's calibration. The color of this bar addi-
tionally indicates the calibration accuracy
through its color: a red bar represents a defi-
cient calibration, a green bar represents good
calibration results. 

The calibration accuracy display

Calibration results can be deficient due to a
number of reasons. If only a small number of
ellipses is detected in the image or if some of
the detected ellipses are partly covered by the
object, the calibration results will be faulty.
You can try to improve such results by using
the manual calibration. 

6.3.2 Manual Calibration
In most cases, the automatic calibration leads to
good results if the object images were taken
with care. However, you can adjust the calibra-
tion results manually to even out any mistakes
of the automtaic calibration routine. 

In order to manually calibrate an object image,
activate this image in the image list. Then
choose Manual Calibration from the Tools
menu or the context menu of the work view. 

Manual Setting of Calibration Points

 

Use the left mouse button to click into the cen-
ter of all visible ellipses of the calibration pat-
tern. If UZR 3D Professional detects an ellipse
close to the defined center, this ellipse then is
circled with red color. If no ellipse is found -
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due to bad lighting conditions and cut off
ellipses - the software draws a red cross into the
work view. 

If, by accident, a set ellipse has to be removed,
simply click it again: it will be deleted immedi-
ately. If you want to move a set point, hold
Apple and the left mouse button and move the
point to the desired location. 

As soon as you marked all visible ellipses, you
can try to calibrate the object image: choose the
Calibrate command from theTools menu or the
context menu of the work view. If the indicated
ellipses and their accuracy are sufficient, the
image is calibrated.

Calibrated image

If the manually detected ellipses were success-
fully used for calibration, the indicated ellipses
are displayed as green crosses in the image list.

Uncalibrated image

If the number of indicated ellipses and/or their
accuracy are insufficient, the image can not be
calibrated. The indicated ellipses will then be
displayed as red crosses in the image list. This
way, you will get a quick overview on which
images were reworked manually.

If a sufficient number of object images was suc-
cessfully calibrated, you can start with the
object separation: activate the Mask mode
(Mask index or Apple-F3). 

6.4 The Mask Mode 

The Mask mode features three different masks
that identify certain areas of the object images: 
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Display of the different object masks in the image list.

• Object: Use this mask to separate the
object from the image background. 

The Object mask is active per default as
soon as the Mask mode is activated. The
object masks are automatically painted
using a flood fill routine. Black-and-
white miniatures of these object masks
are displayed in the image list. 

• Texture on: This mask defines parts of the
object images which, in the later texture
reconstruction process, will definitely be
used to reconstruct the model's texture.
Use the Texture on mask to enhance parts
of the texture that have to be very detailed
(e.g. writing, faces etc.). You will find
more hints on how to use the Texture on
mask in the section Improving the 3D
Model's texture of this manual. 

The Texture on are displayed in the image
list in green color. If the Texture on mode
is active, the images in the image list are
of green color. 

• Texture off: This mask defines parts of the
object image which, in the later texture

reconstruction process, will definitely not
be used to reconstruct the model's texture.
Use the Texture on mask to definitely
exclude parts of object images which lack
quality from the texture reconstruction
process. 

The Texture off masks are displayed in
the image list in red color. If the Texture
off mode is active, the images in the
image list are of red color. You will find
more hints on how to use the Texture on
mask in the section Improving the 3D
Model's texture. 

6.4.1  Separating the Object 
If you activate the Mask mode, the Object mask
is active. Begin with separating the object from
the image background. 

In the Mask mode, the object is separated with a
colored mask layer. All parts of the images that
are painted are then used to reconstruct the
object. 

 Caution  The object has to be separated on
every calibrated object image in order to recon-
struct the 3D model.

As soon as you activate the Mask mode, an
automatic fill routine is used to mask the object
in the images. This works well if the object's
color contrasts with the image background and
if you provided a uniform image background.
In the separate mode, the image list features
black and white miniature masks. This way it is
easy to see which masks have to be reworked. 
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Automatically generated object mask

The outcome of the automatic separation rou-
tine is disturbed by irregular image back-
grounds or deficient illumination of the object.
If the object mask has to be reworked manually,
a number of handy drawing tools is provided. 

6.4.2  Separation Tools 

 Image Zoom 

To work as exactly as possible, it is required to
zoom very far into the object image. UZR 3D
Professional provides a number of comfortable
zoom functions. If you are using a wheel
mouse, use the wheel to zoom in and out the
object image.

Zooming allows precise work

If you zoomed far into the object image you
only see a small part of the object image. Use
Shift-LeftMouse , the cursor keys or the scroll-
bars on the right and bottom of the work view to
move the object image. 

 The Painting Mode 

 

While manually reworking the object masks,
you can switch between the paint and erase
mode. The mode setting defines if the mask is
painted or erased by using some of the separa-
tion tools (Rectangle, Pen, Line, Polygon and
Fill tool). 

Command Icon Shortcut

Zoom 100% =

Zoom Fit% ?

Zoom In .

Zoom Out ,

Command Icon Shortcuts

 Paint Mode 

 

  
Space 

 
 Erase Mode 
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 Mask Display 

 

You can switch between a positive and a nega-
tive mask display. 

Positive mask display 

By default, the positive mask display is
enabled. In the positive mask display, the
painted mask is colored. Areas that have not
been masked are diaphanous. 

Negative mask display 

The negative mask display works vice versa:
areas which were not masked are displayed col-
ored. Parts that have been masked are displayed
diaphanous. 

Use the positive and negative maks display to
easily work on the mask edges. In the positive
mask mode, you can roughly paint the object
with the Pen tool, while in the negative mask
mode you can then use the Fill tool to work on
the mask edges. 

 Caution  Do not mistake the positive/negative
mask display command with the Invert Mask
command. While switching the mask mode only
alters the mask's display, the Invert Mask com-
mand alters the existing mask attributes:
masked parts will become unmasked and vice
versa. 

 Tip  Always keep an eye on the mask display in
the image list. Here, the masks are always dis-
played "as-is". 

Command Icon Shortcut

 Positive 
Mask Display 

 

 
  Apple-M  

 Negative 
Mask Display 
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 Drawing Tools 

 Rectangle Tool 

 

This tool draws a rectangle. When the Erase
mode is activated, the mask outside this rectan-
gle is erased. When the Paint mode is activated,
the rectangle is filled. 

Rectangle tool in the paint mode

The rectangle tool is suitable for the beginning
of the separation process. It erases most of the
non-required mask parts. 

Press the left mouse button and use the mouse
to draw a rectangle around the object. If you
release the mouse button, the mask outside the
rectangle is erased. 

 Pen Tool 

 

Use the pen tool to paint and erase the mask as
if using a real pen.

Pen in paint mode

In order to paint or erase with the pen tool, hold
the left mouse button and move the mouse. 

Pen in erase mode

Command Icon Shortcut

 Rectangle Tool 

 

 

 Apple-R 

Command Icon Shortcut

 Pen Tool 

 

 

 Apple-P 
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 Changing the Pen Size: 

The pen size can seamlessly be changed by
pressing Alt and the left mousebutton and mov-
ing the mouse. The number displayed on the
edge of the cursor corresponds to the pixel size
of the current setting. 

 Tip  If you use the pen tool, it is recommended
to suspend the drawing process from time to
time by releasing the mouse button. This way it
is possible to undo small work steps. In case of
a mistake you then do not have to do the work all
over again. 

 Line Tool 

 

Line tool in paint mode

The line tool is perfectly suited to separate
objects with straight edges. It works similar to

the pen tool. Press the left mouse button and
move the mouse to paint or erase a line. 

Line tool in erase mode

 Chaning the Line Tool's size: 

Similar to the pen tool, the line tool's size is
adjusted with Alt and the left mouse button. 

 Polygon Tool 

 

The polygon tool is used to quickly surround an
area and fill or erase it. It is suited to easily
seize complex objects.

Command Icon Shortcut

 
Line Tool 

 

 

 

 Apple-L 

Command Shortcut

 Polygon Tool  Apple-G 
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Anwendung des Polygonwerkzeugs

The polygon tool draws a line with any desired
number of corner points. As soon as the line
forms an enclosed polygon, this polygon is
filled. The polygon can be closed manually by
connecting any two cornerpoints or by choosing
Close from the polygon tool's context menu. 

Mask filled

A corner point's position can be changed by
holding Apple and clicking the corner point
with the left mouse button. Now, the corner
point can be moved to any desired position
without having to redraw the line. This way,
mistakes are easily evened out. 

 Caution  Corner points can only be moved as

long as the area has not been filled yet. 

 Fill Tool 

 

The fill tool paints or erases the object mask in
similar colored areas. With this tool, large parts
of the object mask can be edited with a single
mouseclick. Switch to Paint or Erase mode and
use the fill tool to paint or erase large or edgy
parts of the object mask by clicking into the
object image with the left mouse button.

Fill tool context menu

The area of the object mask that is filled or
erased by the fill tool is defined by the pixel
color of the object mask. Similar colored pixels
form a region that is then filled or erased. 

Command Icon Shortcut

 Fill Tool 

 

 

 Apple-F 
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Reworking the mask with the fill tool

Sometimes parts of the object mask are affected
that should not be erased or filled. Thus, the tol-
erance of the fill tool can be adjusted. Open the
fill tool context menu by clicking into the object
image and choose any desired tolerance value.
The bigger the tolerance value, the more pixels
will be filled. If you select Custom from the fill
tool context menu, a custom tolerance value
from 1 to 100 percent can be set. 

 Tip  The fill tool can be used to precisely mask
the object outlines. Roughly paint the object
with the pen tool. Set the fill tolerance according
to the object contrast and erase the mask where
it overlaps the object edges.

 Clear Mask / Fill Mask 

With these tools, the whole mask can easily be
erased and filled. 

 Invert Mask 

This tool inverts the existing mask.

 Import Mask.../ Export Mask... 

With these tools, existing masks can be
imported that have been created with any image
editing software (e.g. Adobe Photoshop).

Black-and-white mask

To create a mask with another image editing
software, open the image you wish to mask.
Paint the image background black and the
object white.

Imported mask

Now, activate the object image in the image list
and import the mask directly into UZR 3D Pro-
fessional. 
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Masks created with UZR 3D Professional can
be exported with the Export Mask... tool.

 Caution  Use only black and white to create the
mask. Grey values, depending on their bright-
ness, are either interpreted as black or white.

 Tip  It is recommended to save this mask sepa-
rately; this way you won't lose any existing ob-
ject image data.

 Grow/Shrink Mask 

These tools enable you to grow and shrink the
object mask pixel by pixel. 

 Mask Color 

UZR 3D Professional displays the mask in three
different colors (red [default], green and blue). 

Depending on the color of the object, it is rec-
ommended to adjust the color of the object
mask. Always choose a contrasting mask color.

This way it is easier to tell which parts of the
object are already separated and which have to
be reworked. 

 Using an image's alpha channel 

Many image editing software products offer the
opportunity to directly paint an image's alpha
channel. If an image with alpha channel infor-
mation is opened, UZR 3D Professional will
detect this information and use the alpha chan-
nel to mask the object. 

Using the alpha channel (e.g.: Adobe Photoshop).

Use black and white to paint the image's alpha
channel. The object has to be painted white.
Make sure that the alpha channel is included
when you save the object image. Alpha chan-
nels are supported in PNG, PSD, TIFF, and
TGA image files.

 Selecting certain Texture Parts with 
Object Masks

After masking the object, you can use the Tex-
ture on and Texture off mode to define certain
parts of the object images, which definitely
have to be or definitely will not be used during

Command Shortcut

 Grow Mask  + 

 Shrink Mask  - 

Command Shortcut

 Red Mask Color   Apple-Shift-
R  

 Green Mask Color   Apple-Shift-
G  

 Blue Mask Color   Apple-Shift-
B  
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texture reconstruction. You can change the
mask mode in the Edit menu.

Texture on mode.

You can mask the texture the same way you
masked the object. All masking tools are avail-
able.

Texture off mode.

 Caution  It might happen that certain areas of
the single object images are masked in the Tex-
ture on as well as the Texture off mode. Parts
that are masked in both modes will definitely be
used to reconstruct the texture.

 Tip  Before you start masking some of the im-
ages in theTexture on or Texture off mode, cre-
ate a 3D model first. Then you will immediately
see which parts of the texture have to be im-
proved.

6.5 The 3D Mode 

If the object is separated in every object image,
the 3D model can be created. Activate the 3D
mode with the 3D index or Apple-F3.

The Plain Model

With information about the camera positions
and the object silhouettes, UZR 3D Profes-
sional is able to reconstruct a realistic 3D
model. This model is then provided with the
textures also extracted from the object images. 

The 3D reconstruction process starts automati-
cally as soon as you activate the 3D mode. If
this process fails you should check if the object
is correctly separated in every object image and
if all object images have correctly been cali-
brated. 

Use the mouse to rotate the 3D model in the
work view. With Shift and the mouse button,
you can change the 3D model's position. With
Shift and the mouse button, you can zoom in
and out the 3D model. 
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Plain Model

First, the object's shape is reconstructed creat-
ing a so called Mesh. This plain model is dis-
played in the work view. 

3D Display Settings

The 3D Mode features various information that
can be displayed in the work view. The 3D dis-
play can be adjusted in the View menu. 

• Wireframe: 

 

Displays the 3D model's wireframe.

• Flat: 

Displays the plain 3D model.

• Smooth: 

Smoothes the 3D model.

• Textured: 

Activates the 3D model's texture display.

• Show Cameras: 
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Activates the reconstructed camera posi-
tions display. 

Mesh Resolution

Low mesh resolution

The mesh resolution can interactively be
changed. Use the slider on the bottom part of
the work view to change the number of poly-
gons of the 3D model in realtime. You can also
directly enter the desired number of polygons in
the window on the right side of the slider. 

High mesh resolution

 Caution  The more polygons a 3D model fea-
tures, the larger is the model's data size. If you
want to use your 3D model in the internet, you
might want to avoid large amounts of data since
they lead to longer download times. Check if the
model can be displayed with a smaller number
of polygons without losing too much quality. A
maximum of 1000 polygons is recommended if
you want to export a model for internet usage. 

 Tip  You will recieve the maximum number of
polygons if you open the Preferences dialogue
and set the Voxel resolution to 512. Then close
the dialogue with OK. As soon as the 3D model
is calculated, move the slider the the right end of
the scale. The maximum number of polygons dif-
fers from object to object. 

Texturing the 3D Model

As soon as the mesh of the model is recon-
structed, UZR 3D Professional automatically
starts the texture reconstruction process. This
process is automatically restarted everytime the
mesh resolution is changed. 
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Textured 3D model

UZR 3D Professional extracts the texture infor-
mation directly from the object images. This, on
the one hand, provides a fast and stable solu-
tion. On the other hand, the quality of the gener-

ated object texture directly corresponds to the
quality of the object images. The whole texture
is displayed in the workview when the Texture
mode is activated. Use the Texture index or
press Apple-F5. to activate the work view. 

 Tip  If you first want to work on the 3D model's
shape, the reoccurring texture calculation might
disturb your work flow. If that is the case, it is
recommended to deactivate the texture rexon-
struction in the Preferences dialogue. As soon
as you are satisfied with the object's shape, the
texture reconstruction can be activated again
which will cause the software to immediately
calculate the texture. 

6.6  The Texture Mode 

UZR 3D Professional reconstructs the optimal
object texture from small parts of the single
object images. The whole texture is displayed
in the work view when the Texture mode is
activated.

Reconstructed object texture

The texture is divided in a number of parts;
these parts are called texture charts. Each chart
contains a number of triangles which are high-
lighted on the texture. 

Texture chart display

Use the Texture mode to check the texture qual-
ity before you export the 3D model. You can
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make adjustments in the Preferences dialogue
and achieve customized results. 

 Caution  The Texture mode is only available if
a texture was reconstructed. If the texture recon-
struction is disabled in the Preferences dia-

logue, the Texture mode can not be activated. 

If you are satisfied with the results of the recon-
structions process, you can export the 3D
model. 

6.7 Exporting the 3D Model

The finished 3D model can now be exported.
Choose Export from the File menu. Here you
can choose from a number of different export
formats. 

The Export menu

• UZR: The UZR format is perfectly suited
for internet use. It can be streamed and
seamlessly be integrated in existing data
base infrastructure. The 3D model is
included in HTML pages by a java applet.
Export the UZR file separately or in com-
bination with the applet and a complete
HTML file. 

• C4D: The C4D format saves the 3D
model for further editing with Cinema
4D. The mesh information is saved in a

C4D file. The texture information is
saved separately. 

• 3DS: The 3DS format saves the 3D model
for further editing with 3D Studio Max .
The mesh information is saved in a 3DS
file. The texture information is saved sep-
arately. 

• OBJ:If the 3D model is exported as an
OBJ file, three separate files are saved to
disk. The MTL file contains material
information. The mesh information is
saved in an OBJ file.The texture informa-
tion is saved separately. 

• DXF: The DXF export writes a DXF file
to disk. This file contains mesh informa-
tion. The DXF export does not feature
any texture information. 

• STL: The STL export saves an STL file to
disk. This file contains the mesh informa-
tion. The STL export does not feature any
texture information. 

• VRML: VRML is a common 3D file for-
mat for internet use. When exported to
VRML, two separate files are saved: A
WRL file containing the mesh informa-
tion, and a separately saved texture file. 
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 Caution In order to capture the physical size of
the 3D model, the size of the object pattern used
has to be specified. 

6.7.1  Der 'Export'-Dialog 
If you chose one of the available export for-
mats, you can enter any desired file name in the
appearing explorer window. 

After entering the 3D file name, the export dia-
logue appears (exception: DXF and STL
export). In this dialogue, different export
parameters can be edited that effect the model's
quality and file size. 

The Export dialogue

Depending on the chosen 3D file format, differ-
ent export options are activated:

• Texture Filename: Here, the filename of
the texture file is defined.

• Texture Quality: This slider defines the
quality of the exported texture. 0 repre-
sents the lowest, 100 the highest quality.

• Texture Format: Here, the format of the
exported texture is defined. 

— Embedded Progressive DCT (Dis-
crete Cosinus Transformation):
This texture format is opted for
internet usage. If the 3D model is
saved using this texture format, the
texture information will be
streamed. First, the plain model is
downloaded. As soon as a small
part of the texture information is
downloaded, a rough model texture
is displayed in the browser. The
texture resolution will increase
while the rest of the texture data is
loaded in the background. The Pro-
gressive DCT texture format pro-
vides the internet user with a quick
representative impression of the 3D
model. 

— Embedded JPEG: The texture will
be embedded in the 3D model file
as a JPEG file. 

— Embedded RAW: The texture will
be embedded in the 3D model file
as a RAW file (large amounts of
data)

— JPEG File Interchange Format:
Saves the texture as a spearate JPG
file. 

— Portable Network Graphic: Saves
the texture as a separate PNG file. 

 

• Copyright Information: When exporting
to UZR or VRML, you can enter any
copyright information in this window.
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This copyright text is then saved within
the exported file. 

• Export Camera Positions: If this check-
box is activated, the 3D model will be
provided with information about the cam-
era positions reconstructed by UZR 3D
Professional (VRML and UZR export
only). 

• Write HTML file: When exporting to
UZR, activate this checkbox to write a
complete HTML file to the chosen desti-

nation. This file contains the model as
well as a javascript camera navigation. 

• Copy Applet File: If you are exporting a
UZR file, you can additionally save the
required java applet file (uzrviewer.jar) to
the same destination by activating the
Copy Applet File checkbox. 

If you selected a file name that already exists in
the designated folder, UZR 3D Professional
will ask if you want to overwrite this file. This
way it is made sure that you do not lose any
important data by accident. 

6.8 Saving 

 

UZR 3D Professional saves the project as a
U3D-file on your hard disk. This file includes

the object image files as well as all separation
and calibration data. 

The image files can be saved on your hard disk
directly from within the UZR 3D Professional
interface. You can open the image files directly
from your digital camera. If you want to save
them to disk, simply choose Save Images from
the File menu. Here you can indicate the direc-
tory in which you want to save the object
images. 

6.9 Making Adjustments 

6.9.1  The Preferences Dialogue 
The Preferences dialogue features all recon-
struction parameters of UZR 3D Professional.
Changing these parameters will influence your
3D and texture results. 

Command Shortcut

 Saving a U3D file  Apple-S 

 Saving the object images  Apple-Shift-I 
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The Preferences dialogue 

Use the Preferences dialogue to adjust the
reconstruction quality of your 3D model and the
3D model's texture. The Preferences dialogue is
featured in the Edit menu. 

• Voxel Resolution: The 3D model, the so
called voxel, can be reconstructed in dif-
ferent resolution. Use the Voxel Resolu-
tion slider to adjust the voxel resolution to
your individual needs. 

Small voxel number

A low Voxel Resolution will lead to an
undetailed, rather rough 3D model. 

Large voxel number

The higher the voxel's resolution, the
more detailed the 3D model will be. An
increasing voxel resolution will take UZR
3D Professional longer to reconstruct the
3D model. If you need a highly detailed
3D model, increase the Voxel Resolution
value. 

• Voxel Smoothing: A voxel a cubic object.
Thus, the 3D model is built from a num-
ber of small cubes.

Unsmoothed 3D model

But most objects though feature smooth
surfaces instead of cubic surfaces. Thus,
the model surface built from voxels can
be smoothed. 
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Smoothed 3D model

If the surface is smoothed, details of the
3D model might be lost - especially, if the
model is built with a small voxel resolu-
tion. Coordinate the Voxel Smoothing and
the Voxel Resolution values in order to
obtain the desired 3D model quality. 

• Focal Length Accuracy: UZR 3D Profes-
sional reconstructs the focal length from
the object images. With this information,
the camera position is reconstructed. The
more precise the focal length is deter-
mined, the more precise results will be
achieved. If you increase the Focal
Length Accuracy value, you will get bet-
ter results while the reconstruction pro-
cess will take longer. If you prefer quick
results, decrease the focal length accu-
racy. If you are interested in precise
results, increase the value. Keep in mind
that the focal length reconstruction has to
be done for every object image and that
the calculation time will increase with the
number of object images. 

Recalibrating the object images

If you reconstructed a 3D model and are
not satisfied with the result, adjust the
Focal Length Accuracy value. Then you
have to recalibrate the object images.
Close the Preferences  dialogue and
choose either Calibrate to recalibrate one
object image or Calibrate All to recali-
brate all object images. 

 Tip  If you want to maximize a model's detail
quality e.g. to export it to other 3D modeling
software, separate this detail in the object imag-
es. Open the Preferences dialogue and maxi-
mize the Voxel Resolution value. Adjust the
Voxel Smoothing value and create the 3D mod-
el. You will get a highly resoluted and detailed
model of the object's detail. 

• Texture Reconstruction enabled: If this
check box is activated, UZR 3D Profes-
sional reconstructs the 3D model's texture
as soon as the model's shape is calculated.
If you do not need texture information or
if you want to optimize the shape of the
object before calculating the model's tex-
ture, it is recommended to deactivate the
texture reconstruction. This especially
applies if you work with a highly reso-
luted model since, depending on you
computer's system, the texture recon-
struction can be time consuming. 
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• Texture Width: This value defines the
width of the exported texture. 

• Texture Height: This value defines the
height of the exported texture. 

• Maximal Deformation: This value defines
the maximal deformation of the generated
texture charts. The texture chart consists
of a number of triangles. The higher the
Maximal Deformation value, the larger
the maximal size of single triangles will
be. 

• Max. Border/Area Ratio: The higher this
value, the larger the maximal border size
of a chart will be in comparison to the
chart's area. If you raise this value, you
will receive larger charts with more
frayed edges. 

• Oversampling: This value defines how
the color of a pixel is determined. If e.g.
1x1 is selected, UZR 3D Professional
checks the center of the pixel area to
define this pixel's color. If 4x4 is selected,
the same area is checked at four different
parts, and the color is defined by the aver-
age value of the four detected color val-
ues. With a higher Oversampling value,
you will receive better texture reconstruc-
tion results. 

6.9.2  Generating Object Images 
UZR 3D Professional uses the object separation
information to reconstruct the shape of the 3D
model. Parts of the object that are not visible on
any of the image files thus can not be recon-
structed. In some cases, this leads to deficient
results because some parts of the voxel are not

cut off. In order to optimize the 3D model's
shape, additional object images can be gener-
ated. 

Deficient 3D model

To generate additional object images, activate
the 3D mode. Now, rotate the 3D model in the
work view so the deficient part of the model is
visible. Then, generate an object image by
pressing the Generate Image button or by
choosing Generate Image from the Edit menu.
The generated image is displayed in the image
list. 

Generated image

Now, activate the Separate mode and rework
the object mask of the generated object image
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cutting off the deficient parts of the object. As
soon as this separation is done, go back to the
3D mode. The improved model is reconstructed
and textured. 

Improved 3D model

 Tip  Use the Generate Image command to gen-
erate object images that normally would be un-
usable because the object pattern would not be
visible (e.g. view from the bottom). 

 Caution If you generate artificial object imag-
es to improve the model's shape, you should set
the Voxel Resolution value to 512 and the Voxel
Smoothing value to 0. This way, you obtain the
highest model detail and make sure that no re-
quired parts of the object are cut off. 

 Caution Always make sure that the generated
images show the whole object. Even if parts of
the object are cut off only in a single object im-
age, they will not be reconstructed. Additionally
it is recommended to exclude generated images
from the texture reconstruction process. 

6.9.3  Considering the Calibration 

Results 
The quality of the single object image's calibra-
tion is displayed by the calibration accuracy bar
underneath every object image. The higher the
displayed value, the better the result of the cali-
bration. 

If you receive a low calibration value for an
image, using this image might worsen your 3D
result. You should think about excluding this
image from the reconstruction process. 

Deactivating an object image

Use the calibration information to improve your
results. The required process is a "trial-and-
error"-one: Click the 3D icon underneath the
object image. This image will then not be used
for the reconstruction of the voxel. The model
will automatically be calculated and you can
immediately see if deactivating the object
image worsened or improved your 3D result
without having to delete the image from the
image list and losing valuable calibration and
separation data. 

6.9.4  Improving the 3D Model 
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Texture 
The object texture is directly extracted from the
object images. This is a fast and comfortable
solution but on the other hand implies that the
texture quality can only be as high as the object
images' quality. If some of the images are
blurred or differ in color, the object texture will
be afflicted. This also applies for parts of the
object that can not be seen on any of the object
images. Here, a precise texture reconstruction is
impossible. 

That is why it is recommended to pay attention
to the object image acquisition. If you acquire
high quality object images, you will be able to
reconstruct a high quality model texture. 

If some of the images are blurred or feature dif-
ferent colors, the texture reconstruction will not
lead to satisfying results. The same applies to
parts of the object that are not visible on any of
the object images. An exact reconstruction of
these texture parts can not be expected. 

Keep this in mind and take the object images
with care. If high quality object images are
used, you will get a high quality model texture. 

UZR 3D Professional also offers functions to
improve the object texture's quality: 

• Using Selected Texture Parts: Use the
different masks (see The Mask Mode for
details) to force or exclude some parts of
the object images. 

Faulty Texture 

This is especially recommended if you
have to have higher detail in some parts
of the model's texture, e.g writing on the
object. 

Texture on mode 

If you mask this part in one of the images,
it will be reconstructed from this single
image instead of being composed from a
number of images. This way, the texture
result is improved. 

Improved Texture 

Vice versa, faulty parts of the images can
be excluded from the texture reconstruc-
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tion - e.g. if a cast shadow distorts the
image quality. Use the Texture off mode
to exclude these parts from the texture
reconstruction. 

• Select the images used for texture recon-
struction: UZR 3D Professional uses all
object images to reconstruct the object
texture. You can exclude object images
from the texture reconstruction process.
This is recommended if some of the
images differ in color or focus. 

Activate/Deactivate object image textures
by using the image list context menu or
instead use the Texture icon underneath
every object image. 

• Adjust Brightness/Contrast and RGB Val-
ues: 

If some of the images differ in contrast,
brightness or color values, you should
adjust these. Activate the Adjust mode
and adjust the image quality values. 

Brightness/Contrast Dialogue

If you then activate the 3D mode, you can
check if the texture has been improved. 

RGB Dialogue

 Tip  If object images can not be calibrated be-
cause they turned out too light or dark, use the

brightness and contrast adjustment to empha-
size the ellipses on the object pattern. Now you
can try to recalibrate the object image and undo
the image quality changes without losing the
new calibration data. 

• Adjusting the Texture Reconstruction
Preferences: Use the Preferences dia-
logue to adjust the texture reconstruction
values to your individual needs. 

• Enhancing Generated Object Images:
Parts of the texture that are not visible on
any of the object images are artificially
generated through mathematical interpo-
lation. This also applies to the object's
undersurface. 

You can work on the object undersuface's
texture using a simple trick: First, gener-
ate an artificial object image showing the
object's undersurface. Then, export this
image. 

Open the generated image with any image
editing software. Here, you can paint the
undersurface of the object or map an
image on the undersurface. Save your
changes and reimport the image into the
image list replacing the originally gener-
ated object image. Now, activate this
image for texture reconstruction. 

• Improving the Object Image Quality
using Image Editing Software: Faulty
images can be improved using any image
editing software (e.g. Adobe Photoshop).
Here, all parameters can easily be
changed. 
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 UZR Files on the Web 

If you want to export the finished 3D model for
internet usage, you can export it to the UZR for-
mat. The UZR format is perfectly suited for
internet usage. UZR files are streamed; this
way, the user does not have to endure long
downloads and instead gets an immediate visual
impression. Additionally, UZR files can be used

commercially without charge and, like standard
image files, can seamlessly be integrated in
existing database infrastructure. UZR files can
be viewed with every browser (Internet
Explorer, Netscape, Opera) and on any system
including Linux. 

7.1  Integrating UZR files in HTML 

Like standard image files, UZR files can easily
be integrated in HTML web pages. To view the
3D models in a browser window, the UZR files
plus the required java applet (uzrviewer.jar)
have to be supplied. The java applet is saved to

disk when Copy Applet File is activated during
the UZR export. 

If you activate the parameters Export Camera
Positions and Write HTML File during UZR
export, the following HTML file is written to
disk: 

<HTML>
<HEAD>
<META HTTP-EQUIV="Content-Type" CONTENT="text/html; charset=UTF-8">
<TITLE>UzrViewer</TITLE>
</HEAD>
<BODY>
<p>
 <applet name="Viewer" archive="uzrviewer.jar" code="uzrviewer.Viewer.class" width="600" 
height="400">
  <param name="scene" value="xy.uzr">
  <param name="nocamrt" value="true">
 </applet>
</p>
<script type="text/javascript">
<!--
function setCamera(s)
{
  document.Viewer.setCamera(s)
}
function toggleLight(s)
{
  document.Viewer.toggleLight(s)
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}
function startAnim()
{
  document.Viewer.startAnim()
}
function resetNodes()
{
  document.Viewer.resetNodes()
}
</script>
<table border="1">
 <tr>
  <th>
  Camera
  </th>
  <th>
  Lights
  </th>
  <th>
  Control
  </th>
 </tr>
 <tr>
  <td>
   <form>
    <input type="radio" checked="checked" name="Camera" onclick="setCamera(this.value)" val-
ue="Camera 1"> Camera 1<br>
    ...
   </form>
  </td>
  <td>
   <form>
   </form>
  </td>
  <td>
   <form>
    <input type="button" name="Start" onclick="startAnim()" value="Start">
    <input type="button" name="Reset" onclick="resetNodes()" value="Reset">
   </form>
  </td>
 </tr>
</table>
</BODY>
</HTML>
    

You can adjust this file for your individual pur-
poses. Three parts of this file are of special
interest.

In the first of these parts, the model is defined
which will be loaded into the applet window.
Additionally, some model display parameters
can be defined: 

<applet name="Viewer" archive="uzrviewer.jar" code="uzrviewer.Viewer.class" width="600" 
height="400">
  <param name="scene" value="xy.uzr">
  <param name="nocamrt" value="true">
  <param name="bgcolor" value="#XXXXXX">
  <param name="bgimage" value="xy">
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  <param name="spinx" value="xy">
  <param name="spiny" value="xy">
  <param name="spinbrake" value="xy">
  <param name="camdist" value="xy">
  <param name="s_cameras" value="xy">
  <param name="s_lights" value="xy">
  <param name="s_reset" value="xy">
  <param name="s_start" value="xy">
</applet>
    

• 'width'/'height': The size of the applet
window that shows the 3D model can be
set with the width and height parameters. 

• 'scene': This parameter defines the model
which is loaded into the applet window.
Enter the name and location of the desired
UZR file. 

 Caution  Keep in mind that this definition is
case sensitive! 

• 'nocamrt': The nocamrt parameter has
two possible values: true (default) und
false. It defines if a camera rotation is
allowed. If the parameter is set to "false",
the camera position can be moved if you
click in the image background and move
the mouse. 

 Caution  This camera navigation is quite diffi-
cult to handle. The user might "lose" the object
somewhere in the object window. It is recom-
mended to leave the parameter value set to
"true". 

• 'bgcolor': The bgcolor parameter defines
the color of the java applets background.
Enter the code of the desired color after
the term "value" (e.g.: "#FFFFFF" for a
white, "#000000" for a black back-
ground). You will find an overview on all

available so called hexadecimal colors in
every HTML documentation. 

• 'bgimage': The bgimage parameter
defines an image file that can be dis-
played in the java applet's background.
This way, UZR files can seamlessly be
integrated in HTML web pages. Enter the
name of the desired JPG or GIF file after
the term "value". 

• 'spinx/spiny': The spinx parameter defines
an initial vertical rotation of the 3D
model. If you enter a positive number
behind the term value, the 3D model
rotates clockwise. A negative value leads
to a counterclockwise rotation. Corre-
spondingly, the spiny value defines an
initial horizontal rotation. A positive
value rotates the 3D model from top to
bottom, and vice versa. 

• 'spinbrake': The spinbrake parameter
defines, how long this initial rotation
lasts. Enter any value from 0 (no rotation)
to 1 (infinite rotation). If this parameter is
left undefined, its default value is set to 0.
If no initial rotation but the spinbrake
parameter is set, the 3D model's rotation
initiated by the user lasts according to the
spinbrake parameter value. 
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• 's_cameras': This parameter defines the
name of the applet's context menu which
lists all available camera positions. If the
parameter is not explicitely set, the
default value "Cameras" is used. 

• 's_lights': This parameter defines the
name of the applet's context menu which
lists all available light sources. If the
parameter is not explicitely set, the
default value "Lights" is used. 

• 's_reset': This parameter defines the name
of the applet's context menu which resets

the 3D model display to its original posi-
tion. If the parameter is not explicitely
set, the default value "Reset" is used. 

• 's_start': This parameter defines the name
of the applet's context menu which starts
an animation if existing. If the parameter
is not explicitely set, the default value
"Start" is used. 

In the second part, the camera positions that are
controllable by javascript are listed:

<input type="radio" checked="checked" name="Camera" onclick="setCamera(this.value)" value="Cam-
era 1"> Camera 1<br>
...
    

The camera names can easily be edited to
improve the navigation. For example, you can

delete some of the camera positions and name
the others "front", "back" and so forth. 

Finally, you can also edit the button names:

<input type="button" name="Start" onclick="startAnim()" value="Start">
<input type="button" name="Reset" onclick="resetNodes()" value="Reset">
    

Simply edit the name input or delete them if not
needed.

 Tip  If you activate the option Write HTML file
during UZR export, you can copy the required
HTML source code directly from this file and
paste it into any other HTML page (View source
from the context menu of your browser window). 
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7.2 Viewing UZR files in the Browser

Mesh Data

The UZR files are automatically loaded into the
browser window. First, the plain mesh data is
displayed. The texture data is streamed, mean-
ing that first a low resolution texture is visible. 

Fully textured model

This texture will become higher and higher res-
oluted until the whole texture data is loaded.
This way the user does not have to bear up long
download times and gets an immediate visual
feedback - even with a slower modem connec-
tion. 

You can move the camera around the object by
dragging the object with the left mouse button.
If you hold Alt and the left mouse button, you
can zoom in and out the object by moving the
mouse back and forth. 

 Caution  This functionality is not available on
Macintosh. Use the applet context menu (Apple/
Mouseclick) to control the 3D display. 

7.2.1  Controlling the 3D Display 
Using Javascript Controls 
The 3D model display can be controlled with
the javascript controls under the applet window
or with the applet window context menu. Click
the window with the right mouse button to open
the context menu. 

• Start: Starts an animation if existing 

• Reset: Resets the 3D model position 

• Cameras: Lists the camera positions if
existing 

• Lights: Lists the light sources if existing 

• About this file: Displays the copyright
information included during UZR export 

• About UZR Viewer...: Displays a browser
window with information on the UZR
Viewer 
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 UZR 3D Professional Reference 

8.1 Basics

8.1.1 Starting UZR 3D Profes-
sional 
There are two ways to start UZR 3D Profes-
sional after a successful installation:

• Open UZR 3D Professional by double
clicking the UZR 3D Professional icon on
your desktop. 

• Open UZR 3D Professional by double
clicking an existing U3D file. 

It is also possible to drag and drop existing U3D
files onto the UZR 3D Professional icon or the
UZR 3D Professional work view. 

8.1.2 Exiting UZR 3D Professional 
To exit UZR 3D Professional, choose Quit from
the UZR 3D menu. Or simply close the UZR 3D
Professional program window with Apple-Q or
the mouse. Before exiting, you are asked if you
want to save your changes on the current
project.

8.1.3  Undo/Redo 

 

UZR 3D Professional features an Undo/Redo
function that enables you to undo/redo any real-
ized project changes (Undo and Redo in the
Edit menu or the corresponding icons in the
document bar). The Undo/Redo is working
mode comprehensive. If, for example, you
edited one of the object masks and activate the
3D mode, the changes can be undone with the
Undo command without having to change the
working mode. 

Command Icon Shortcut

 Undo 

 

 

 Apple-Z 

 Redo 

 

 

 Apple-Y 
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8.1.4  The Personalize Dialogue 

The Personalize dialogue 

Use the Personalize dialogue (Help menu) to
edit your registry information. 

 Caution  Any changes will take effect the next
time you start UZR 3D Professional. 

8.2 The User Interface 

8.2.1 The UZR 3D Menu 
The UZR 3D menu features UZR 3D Profes-
sional copyright information, allows you to edit
the 3D reconstruction settings and to exit the
application. 

 

8.2.2 The Files Menu 
The File menu features all functions you need
to administrate your image and 3D files. 

Command Function Shortcut

 About 

 Displays UZR 3D 
Professional 

copyright infor-
mation. 

 Prefer-
ences... 

 Changes the 3D 
reconstruction 

settings. 
 

 Quit 

Exits UZR 3D 
Professional after 

asking you to 
save your 

changes on the 
current project. 

 Apple-Q 

Command Function Shortcut

 New Creates a new 
project.  Apple-N 

 Open Opens an exist-
ing U3D file.  Apple-O 

 Save  Saves the cur-
rent project.  Apple-S 

 Save as... 

Saves the current 
project at a 

scheduled desti-
nation.

 Apple-
Shift-S 

 Open 
images... 

Opens the object 
images.  Apple-I 

 Save 
images... 

Saves the object 
images.

 Apple-
Shift-I 

 Print Pat-
tern... 

Defines and 
prints the object 

pattern.
 Ctrl-P 

 Export  Exports the 3D 
model.  
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8.2.3 Edit Menu 
The Edit menu features functions that simplify
working with UZR 3D Professional. Any mis-
takes can be corrected in a second. 

 

 Recent files  
Apple+1,2,...,

5 

 Opens the 
recently used 

U3D files.
 

Command Function Shortcut

 Undo  Undoes the last 
work step.  Apple-Z 

 Redo  Redoes the last 
work step.  Apple-Y 

 Cut 
Cuts the selec-

tion and copies it 
into the clipboard.

 Apple-X 

 Copy 
Copies the selec-
tion into the clip-

board.
 Apple-C 

 Paste 
 Pastes the clip-
board into the 

selection. 
 Apple-V 

 Paste as 
new 

 Pastes the clip-
board as a new 
image into the 

image list. 

 Apple-
Shift-V 

 Delete Deletes the 
selection.  Del 

 Paint Mode  Activates the 
Paint Mode.  

Space 
  Erase Mode   Activates the 

Erase Mode.

Command Function Shortcut

 Object Mask 

 Activates the 
object mask 

which is used to 
separate the 

object from the 
image back-

ground. 

 

 Texture On 
Mask 

 Activates the 
Texture On 

mask. This mask 
defines parts of 

the object images 
that will definitely 
be used for tex-
ture reconstruc-

tion. 

 

 Texture Off 
Mask 

 Activates the 
Texture Off 

mask. This mask 
defines parts of 

the object images 
that will definitely 
not be used for 
texture recon-

struction. 

 

 Use Image 
for Voxel 

Reconstruc-
tion 

 Activates/Deacti-
vates the current 
object image for 
the voxel recon-

struction process. 

 

 Use image 
for texture 
reconstruc-

tion 

 Activates/Deacti-
vates the current 
object image for 

the texture recon-
struction process. 

 

Command Function Shortcut
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8.2.4  View Menu 
The View menu features all functions to adjust
the view mode of the UZR 3D Professional
work view. 

8.2.5  Tools Menu 
The Tools menu features all functions to adjust
the view mode of the UZR 3D Professional
work view.

Command Function Shortcut

 Next Image 

Switches back to 
the previous 

object image in 
the image list.

 PgUp 

 Previous 
Image 

Jumps to the fol-
lowing object 
image in the 
image list. 

 PgDown 

 Zoom 100% 
Displays the 
actual image 

size.
 = 

 Zoom Fit% 

Adjusts the 
image to the cur-

rent work view 
size.

 ? 

 Zoom in Zooms into the 
object image.  . 

 Zoom Out Zooms out the 
object image.  , 

 Red Mask 
Activates the red 

mask color 
(default).

 Apple-
Shift-R 

 Green Mask 
Activates the 
green mask 

color.

 Apple-
Shift-G 

 Blue Mask Activates the blue 
mask color.

 Apple-
Shift-B 

 Wireframe 
Activates the 

wireframe dis-
play.

 Apple-W 

 Flat Displays the plain 
3D model.  

 Smooth 
Smoothes the 
displayed 3D 

model.
 

 Textured 
Activates the 3D 
model's Texture 

display.
 

 Show Cam-
eras 

 Displays the 
reconstructed 

camera positions. 
 

Command Function Shortcut

 Adjust 
Brightness/
Contrast... 

Enhances the 
current object 

image's quality.
 

 Adjust 
RGB... 

Enhances the 
current object 

image's quality.
 

 Import 
Image... 

Imports an object 
image and 

replaces the cur-
rent object 

image.

 

 Export 
Image... 

 Exports the cur-
rent object 

image. 
 

 Manual Cali-
bration 

Enables the man-
ual image calibra-

tion tool.
 

Command Function Shortcut
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8.2.6  Window Menu 
Use the commands of the Windows menu to
activate the different UZR 3D Professional
working modes. 

 

8.2.7  Help Menu 
The Help features all help functions. 

 Calibrate 
Calibrates the 
current object 

image.
 

 Calibrate all 
Calibrates all 

object images in 
the image list.

 

 Rectangle 
tool 

Activates the 
Rectangle Tool.  Apple-R 

 Pen Tool Activates the Pen 
Tool.  Apple-P 

 Line Tool Activates the line 
tool.  Apple-L 

 Polygon tool Activates the 
Polygon Tool.  Apple-G 

 Fill Tool Activates the Fill 
Tool.  Apple-F 

 Clear Mask Clears the exist-
ing object mask.  

 Fill Mask Fills the current 
object mask.  

 Invert Mask Inverts the exist-
ing object mask.  

 Shrink Mask 
Successively 

shrinks the object 
mask.

 - 

 Grow Mask 
Succesively 
extends the 
object mask.

 + 

 Import 
Mask... 

 Imports an exist-
ing object mask.  

 Export 
Mask... 

 Exports the cur-
rent object 

image's mask. 
 

 Generate 
Image 

Generates an 
artificial object 

image.
 Apple-G 

Command Function Shortcut

Command Function Shortcut

 Adjust Mode Activates the 
Adjust Mode.  Apple-F1 

 Calibrate 
Mode 

 Activates the 
Calibrate mode.  Apple-F2 

 Mask Mode  Activates the 
Mask mode.  Apple-F3 

 3D Mode  Activates the 3D 
Mode.  Apple-F4 

 Texture 
Mode 

 Activates the 
Texture Mode.  Apple-F5 

Command Function Shortcut

 Online Help 

 Displays the 
UZR 3D Profes-

sional online 
help. 

 F1 

 UZR 3D 
Forum 

 Opens the UZR 
3D Forum in an 
Internet Explorer 

window.

 

 Personalize 
 Adjusts registra-
tion of UZR 3D 
Professional. 
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8.2.8 The Image List 

The Image List

The image list features a thumbnail overview of
all loaded object images. Depending on the
working mode activated, the image list offers a
number of different functions. In the View
mode, use the image list to check if all and, in
case, wrong object images were loaded. In the
Calibrate mode, the thumbnails offer a minia-
ture view of the calibrating routine's results as
well as the calibration's accuracy. In the Sepa-
rate mode, the image list features black-and-
white miniatures of the painted object masks.
By activating the icons under each object image
in the image list, these images are queued for
the texture and voxel reconstruction process. If
this is done in the 3D mode, the voxel recon-
struction/texturing process is restarted automat-
ically after changing the status of each object
image. 

If you click an object image in the image list
with the right mouse button, the image list con-
text menu appears. This menu features all com-

mands that you need to edit the object image
selection. 

8.2.9 The Index

The Index

 

Use the index to activate the different UZR 3D
Professional working modes. It is always possi-
ble to switch to any desired mode. A mode is
activated by clicking the corresponding index
card or using the F1 to F5 shortcut. 

8.2.10 The Work View 

The Work View

As soon as an object image is loaded into the
image list, the images can be displayed and
edited in the work view. In the 3D mode, the 3D

Shortcut Function

 Apple-F1, -
F2,..., -F5 

Changes the UZR 3D Profes-
sional working mode.
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model is displayed in the work view. Also, the
reconstructed camera positions are indicated by
small green cones. In the Texture mode, the
work view features the whole object texture. 

8.2.11 Icon Bars

The Standard Bar

The standard bar features zoom shortcuts that
allow you to zoom in and out the object images.

The Tool Bar 

The tool bar features all tools needed for the
manual object separation. Use the paintbrush
and the eraser icon to switch from paint to erase
mode. The other icons activate the different
object separation tools. 

The Render Bar 

The icons of the render bar allow immediate
access to the 3D display. Use the icons of the
render bar to analyse yout 3D model and to
enhance its quality. 

8.3 System Requirements 

• PC: Windows 98/ME/NT/2000/XP 

P233 MHZ, 32 MB RAM (64 MB recom-
mended) 

• Mac: Mac OS X 10.1.5. or higher 

G4, 733 Mhz 

• 800x600 graphics adapter, 16Bit (High-
color), 50 MB free hard disk space, digi-
tal camera/webcam, printer
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Tutorial

Use this Tutorial to practically follow and
understand the UZR 3D Professional wrkflow.
You will find the required image and U3D files

in the UZR3D/Tutorial directory on your hard
drive.

9.1 Loading the Images

Start UZR 3D Professional. Then, open the
object images with the Open Images command
from the File menu. The images image01.jpg to
image17.jpg are loaded into the image list. 

Loading the object images

This step is saved as step1.u3d in the Tutorial/
Steps directory on your hard drive. 

9.2 Calibrating the Object Images

Open the Preferences. Set the Focal Length
Accuracy value to 100%. Close the dialogue
with the OK button. 

Next, activate the Calibrate mode by clicking
on the Calibrate index. The images then are
calibrated. 
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Calibrated images

The results of the automatic calibration are
quite good. Yet, it can be improved in four of
the images. You should check if the calibration
accuracy can be increased with manual calibra-
tion. 

Faulty ellipse detection

Activate the image image03.jpg. You will see
that UZR 3D Professional detects ellipses that

are partly covered by the statue. You should
remove these ellipses with the manual calibra-
tion tool. 

Improved result

Open the work view context menu with a right
mouseclick. Now, choose the Manual Calibra-
tion command and remove the faulty ellipses
with a left mouseclick. Than activate the Cali-
brate command with a left mouseclick. The cal-
ibration accuracy increases from 0 to 66
percent. 

Do the same work on image image04.jpg. Here
you can increase the calibration result from 33
to 65 percent. The image calibration accuracy
in image12.jpg can be improved from 6 to 85
percent. image01.jpg's calibration result can be
increased to 64 Prozent. 

The calibrated images are saved as step2.u3d in
the Tutorial/Steps directory on your hard drive. 

9.3 Object Separation

Activate the Mask Mode. On the upper half, the statue's separation is
good enough. Yet, the object masks in the bot-
tom part of the statue have to be increased to
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achieve a higher level of reconstruction detail.
Here, a slight shadow of the object has
decreased the quality of the automatic separa-
tion. 

Activate the image image07.jpg. Then activate
the pen tool and increase the pen size. Be sure
that the paint mode is ative. Then roughly paint
the deficient mask parts. 

Next, activate the fill tool. Set the fill tool's tol-
erance to 25% and activate the erase mode.
Now erase the redundant parts of the mask fast
and easy with a couple of right mouse clicks. 

The mask is now improved. The last thing you
have to do is delete the mask on the calibration
points with the pen tool. 

Do the same thing with all other object images.
We recommend to work "tool by tool": first,
rework all images with the pen tool, then with
the fill tool and so forth. You can step through
the object images using the PgUp/PgDn hot-
keys. This way, you will increase your work
flow. 

You do not have to delete the mask on the
points of the calibration pattern in every image;
it is sufficient to remove it in image07.jpg and
image10.jpg. 
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These steps are saved as step3.u3d in the Tuto-
rial/Steps directory on your hard drive. 

9.4 3D Reconstruction

Activate the 3D mode with a clock on the 3D
index. The 3D model of the statue is being
reconstructed. 

Using standard settings

After reconstruction, you will realize that parts
of the torch of the statue are missing. At the
same time, the right arm's reconstruction is
deficient. Improve the reconstruction result by
adjusting the UZR 3D Professional settings. 

Improved model

Open the Preferences dialogue and set the
Voxel Resolution value to 135 and the Voxel
Smoothing value to 4. Close the dialogue with
OK. 

The object reconstruction is restarted automati-
cally. After the calculation of the model,
increase the number of polygons from 1000 to
7500. The deficient parts of the model are now
improved.

Rotate the statue in the work view so that you
see it from above. You will see that parts of the
shoulders and upper arms have not been cut out
the voxel. These parts were not cut off because
no image was made from this position. 

Open the Preferences dialogue and set the
Voxel Resolution value to 250 and Voxel
Smoothing to 0. Deactivate the texture recon-
struction. Close the dialogue with OK and acti-
vate the 3D mode. 

As soon as the 3D model is reconstructed, set
the polygon count to maximum by dragging the
slider to the far right. Now, rotate the statue to
view the deficient parts from above. 
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Deficient Parts of the model

Now, generate an artificial onject image. Acti-
vate the Separate Mode and delete the mask
over the deficient parts of the mask using the
pen tool. 

Working on the generated object image

If you are satisfied with the 3D model, set the
poygon count back to 7500. Open the Prefer-
ences dialogue and set the Voxel Resolution and
Voxel Smoothing  values back to 135 and 4.
Activate the texture reconstruction and close
the dialogue with OK. The improved model is
reconstructed and textured. 

Improved model

Rotate the model in the work view so you can
see the statue's face. You will find that the tex-
ture in this area needs some improvement. 

The texture of the statue's face was created from
a number of images. In order to improve the
results, you have to mask the statue's face in
one of the object images using the Texture on
mask. 

Faulty Texture

Activate the Mask mode. Now, activate the
image image06.jpg. Use the Pen tool to paint
the face of the statue. Mask parts that overlap
the edges can easily be erased with the fill tool. 
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Textur on Mode

Now, reactivate the 3D mode. The improved
texture is reconstructed and mapped onto the
model. 

Improved Texture

Parts of the texture that are not visible on any of
the images are artificially generated using
mathematical interpolation. These parts,
depending on the object images, might be defi-
cient. 

Undersurface of the model

Parts of the texture that are not visible on any of
the images are artificially generated using
mathematical interpolation. These parts,
depending on the object images, might be defi-
cient. 

Exporting the generated object image 

This artificially generated image will be dis-
played in the image list. Export this image with
the Export Image command from the image list
context menu and save the image to disk. 

Next, open the image with an image editing
software (e.g. Adobe Photoshop). Edit the gen-
erated image and save it to disk. The example
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image tutorial.tga was painted black and pro-
vided with a writing. 

Reworking the generated image

Reimporting the image

Next, open the image with an image editing
software (e.g. Adobe Photoshop). Edit the gen-
erated image and save it to disk. The example
image tutorial.tga was painted black and pro-
vided with a writing. 

Improved texture

You are now finished with the model. It can be
exported (Export in the File menu). 

These steps are saved as step5.u3d in the Tuto-
rial/Steps directory on your hard drive. You
will find the exported 3D files in the Tutorial/
Export directory. 
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FAQ

When plane parts of the object are recon-
structed, the turn out tapered or even round
shaped. What can I do to avoid this?

UZR 3D Professional uses the detected calibra-
tion point and object separation information to
reconstruct the camera positions and the object
shape. Thus, the software can only relate to
what can be seen in the images. When you
check your object images, you will find that
there are no images that show the object
directly from the side. The object surface can
only be reconstructed as seen in the object
images. You can improve your result by shoot-
ing additional object images that show the
object directly from the side. If you want to
reconstruct extremely plane objects, UZR 3D
Professional then might not be able to detect
the calibration points of the object pattern.

If that is the case, there are two ways to
improve your results: Either you set up the
object on the edge to take the object images or
you generate artificial object images. In these
generated images you have to "cut off" the
unnecessary parts of the voxel by reworking the
object masks. These parts will be vanishing as
soon as the 3D reconstruction is restarted.

How can I reconstruct the object's undersur-
face?

UZR 3D Professional can only reconstruct what
is visible in the object images. If the object is
standing on its undersurface, the undersurface's

texture naturally cannot be reconstructed.
Instead, you should hang the object up free-
floating over the object pattern in order to make
its undersurface visible.

The reconstructed 3D model is "spotted".
What can I do about it?

As the object's shape, its texture is extracted
directly from the object images. Thus, the tex-
ture quality can only be as high as the object
images' quality. A "spotted" texture can have
several reasons:

• The object is faulty illuminated. 

• The object is faulty separated. Parts of
the image background are used for the
texture reconstruction. 

• The calibration was not exact enough.

Try this to improve the texture quality:

• Improve the image calibration. Raise the
focal length accuracy value in the  Pref-
erences  dialogue. Raise the voxel resolu-
tion value as well and recalibrate the
object images.

• Check the object masks . If required,
rework the object masks, especially on
the object edges.

• Only use assorted object images for the
texture reconstruction. If you only acti-
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vate images for the texture reconstruction
that do not differ in color, the texture will
turn out more even colored. Use the
checkbox underneath the images in the
image list to exclude the nonrequired
images from the texture reconstruction
process.

•  Adjust brightness and contrast of the
object images Use the featured Adjust
Brightness/Contrast dialogue to enhance
the quality of the object images.

•  Enhance the object image quality with an
image editing software. You can readjust
the single object image's color with an
image editing software (e.g. Adobe Pho-
toshop). You don't even have to close
UZR 3D Professional to do so; simply
copy the images from the image list and
paste them into the image editing soft-
ware. Here, you can undertake the
required adjustments and then copy the
images again to paste them into the UZR
3D Professional image list.

The 3D is cut off on one side. How come?

This might have happened for three reasons: 

• The object separation is faulty in one or
more object images. Check the object
masks and rework them if required.

• The part of the object is cut off in one or
more object images. Check the object
images. If you find one or more images
not showing the whole object, simply
delete these images from the image list
and restart the object reconstruction pro-
cess.

• One or more object images were not cor-
rectly calibrated. Check the image cali-
bration. If the calibration failed in one or
more images, delete and replace them
with equivalent images that can be cali-
brated. You might also try to adjust con-
trast and brightness of the object image so
the object pattern is easier to identify.

The 3D model's edges are greyishly blurred.
Why?

UZR 3D Professional extracts the texture infor-
mation directly from the object images. Parts of
the object texture invisible on the object images
(e.g. the objects undersurface) are artificially
generated by interpolating between the visible
texture edges. Here, blurry edges can be created
if the object was not exactly separated on some
of the images. Then small visible parts of the
object pattern are included in the object mask.
These white parts are included in the interpola-
tion process and lead to the model's 'blurriness'.

Adjust the object masks to avoid the blurry
edges. Use the zoom function to work precisely.
This way, you will not cut of parts of the object.
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What do I have to consider, if I want to pub-
lish 3D models in the web?

The higher the polygon number of the number,
the bigger its UZR file will be. And the bigger a
files, the longer it will take to download, and,
thus, the longer a user has to sit in front of his
browser window twiddling his thumbs. To
avoid this, reduce the polygon number as far as
possible, if you are optimising a 3D model for
the internet.

Thin parts of the object are cut off in the 3D
model. Why? 

Through the image calibration, UZR 3D Profes-
sional reconstructs the camera position from the
object images. This information then is used
together with the object mask information to
reconstruct the 3D model. The accuracy of the
calibration can be adjusted. The more accurate
the calibration, the longer it takes. But if the
calibration's accuracy is not sufficient, too
much of the voxel might be cut off.

In order to avoid this, open the Preferences dia-
logue in the Edit menu and change the Focal
Length Accuracy value. 

If you maximize this value, the 3D model is
reconstructed as accurate as possible. Addition-
ally, you should increase the Voxel resolution
value and decrease the Voxel Smoothing value.
Then, open the image list context menu and
choose Recalibrate All. Now all object images
are recalibrated, and an improved 3D model
will be reconstructed.

The 3D model has holes I can actually look
through. What can I do?

The object separation mask is faulty on one or
more images.
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If a part of the object is not masked even in only
one image, this part will already be missing in
the 3D model. 

Check the object masks and correct them. If
you change the object mask color, unmasked
parts of the object might become easier to be
seen.

How can I shorten the image separation pro-
cess?

If you take care during the object image acqui-
sition process, the image separation process
pretty much working automatically. As you can
see with the object images provided in the tuto-
rial files on your UZR 3D Professional CD
ROM, it is in most cases sufficient to simply
place a white sheet of paper underneath the
object pattern. If you have to separate the object
manually from the image background, there are
some tricks that will ease this process:

• Use the fill tool to erase parts of the
masks. 

Roughly paint the object mask using the
pen tool. 

The parts of the mask that overlap on the
object edges can easily be erased with the
fill tool. Simply adjust the fill tool's toler-
ance. This way you can easily paint per-
fect masks.

• Repaint the objects edges and fill the
object. 

If you repaint the object edges you can
easily fill the object and set the fill tool's
tolerance to 100%, it is easy to fill the
whole object. 
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This method is especially recommended
for objects with straight edges. Use the
line tool or the polygon tool to repaint
straight object lines and fill the object.

The 3D reconstruction result is missing a lot
of the objects details. What can I do about it?

You will get a more detailed 3D model if you
adjust the size of the object pattern to the size of
the object you want to reconstruct. The smaller
the object pattern compared to the object, the
more details will be reconstructed. Make sure
though, that the object does not cover any of the
object patterns calibration points.

Some of the object images can not be cali-
brated. Why?

UZR 3D Professional only calibrates object
images if two of the four sides (three corner
points) of the object pattern are visible. Check
the problematic images. If too few calibration
points are visible or parts of the pattern are cut
off, the image is not useable.

If the object pattern is captured in the object
image and the image can not be calibrated
because it is too light or too dark, it might help
if the image's brightness and contrast is adjusted
to emphasize the object pattern. Then recali-
brate the object image. After the object image
was calibrated correctly, simply undo the image
quality changes. This way, the image can still
be used for texture reconstruction. The calibra-
tion data remains unaffected.

 Caution This approach is only recommended if
the image can not be calibrated only due to the
image's quality. If it can not be calibrated be-
cause the object pattern does not lay plane, the
image quality enhancement might also be suc-
66



cessful. But in this case, the camera position is
reconstructed imprecisely. This might lead to a
deficient 3D model.

 Cavities of objects are not reconstructed.
Why? 

UZR 3D Professional reconstructs the object's
shape by combining the object silhouette infor-
mation with the camera position to "carve" the
cubic voxel. Thus, UZR 3D Professional cannot
recreate cavities unless these cavities go all
through the object and form proper holes. 
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Error Messages

A TrueColor display is recommended to run
UZR 3D Professional . Do you want to con-
tinue?

The ideal color depth (TrueColor) is 24 or 32
Bit (millions of colors). If the color resolution is
lower than that (thousands of colors), the color
display might be falsified. This only affects the
texture display, not the texture data itself.

Your OpenGL implementation supports tex-
tures sizes up to x by y pixels. The current
texture is a by b pixels so the display quality
will be degraded.

The reconstructed texture information is too
large for the graphics card memory supported
by OpenGl. The texture display is automatically
adjusted. The display quality might differ from
what would theoretically be possible. The tex-
ture is not lost, though. When the 3D model is
exported, all texture data is included.

Empty voxel at image x.

The separation information given by the indi-
cated object image does not result in an object
with significant volume. A reason for this might
be an improper separation mask. Rework the
object image's mask and restart the reconstruc-
tion process. Another reason might be a
wrongly calibrated object. You can check the
assignments of the identified object pattern cor-
ners in the "Calibration View". Try to recali-

brate or to improve the contrast of the object
image. 

Printing aborted...

The printing of the object pattern has been
aborted.

Opening aborted...

The opening of the object images has been
aborted.

This system has no OpenGL support.
OpenGL is required to run UZR 3D Profes-
sional. Exiting.

OpenGL is required to display the reconstructed
3D model. If your system does not feature
OpenGL support, UZR 3D Professional can not
run. Try to find out if your system can be
upgraded with a new graphics driver that sup-
ports OpenGL.

Calibration pattern does not fit onto page.
Printing aborted.

The calibration pattern size is too large for the
printable area of the selected paper size. Either
adjust the pattern size or select a different paper
format in the printer setup.

The maximum number of patterns is limited
to 64.
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If you excel a number of 64 pattern definitions,
no new pattern sizes can be defined. Instead,
you have to delete or adjust an old one.

The current image (%1, %2) has a different
size than the imported image (%3, %4).
Importing image aborted.

If you import an image into the image list to
replace an image, both images have to have the
same resolution. Otherwise the import will fail.

The current image (%1, %2) has a different
size than the imported mask (%3, %4).
Importing mask aborted.

If you import a mask created with an external
image editing software, the mask has to have
the same resolution as the image in the image
list. Otherwise, the import is aborted.

No valid help file found. Would you like to
setup your language settings?

Adjust the language settings in the Personalize
dialogue to a language in which the online help
is available.
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